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Question Number : 1 Question Id : 2549896363 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is Question
Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
A ______ is a utility program that rearranges files and unused disk space to optimise operations.
Options :
1.  compression tool
2.  disk cleanup tool
3.  backup utility
4.  disk defragmenter
  
Question Number : 1 Question Id : 2549896363 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is Question
Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
________ एक यूटीिलटी �ो�ाम है, जो संि�याओ ंके अनुकूलन के िलए फाइलो ंऔर अ�यु� िड� अंतरालो ंको पुन��व��थत करता है।
Options :
1.  क�ेशन टूल
2.  िड� �ीनअप टूल
3.  बैकअप यूिटिलटी
4.  िड� डी�े��टर
  
Question Number : 2 Question Id : 2549896712 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is Question
Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
3 Mega Pixels (3MP) means ______.
Options :
1.  2048×1536 Pixels
2.  1240×480 Pixels
3.  340×280 Pixels
4.  540×450 Pixels
  
Question Number : 2 Question Id : 2549896712 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is Question
Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0



Correct Marks : 1 Wrong Marks : 0
3 मेगा िप�ल (3MP) का अथ� है ______।
Options :
1.  2048×1536 िप�ल
2.  1240×480 िप�ल
3.  340×280 िप�ल
4.  540×450 िप�ल
  
Question Number : 3 Question Id : 2549897064 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is Question
Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
To make the number pad act as directional arrows, you press the ______ key.
Options :
1.  Num Lock
2.  Caps Lock
3.  Arrow Lock
4.  Shift
  
Question Number : 3 Question Id : 2549897064 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is Question
Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
नंबर पैड को िदशा�क तीर के �प म� काय� करने के िलए, आप ______ कंुजी दबाते ह�।
Options :
1.  Num Lock
2.  Caps Lock
3.  Arrow Lock
4.  Shift
  
Question Number : 4 Question Id : 2549897069 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is Question
Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
What type of software is LINUX?



Options :
1.  Disk Cleanup Tool
2.  Operating System
3.  Utility software
4.  Application software
  
Question Number : 4 Question Id : 2549897069 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is Question
Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
LINUX िकस �कार का सॉ�वेयर है?
Options :
1.  िड� �ीनअप टूल
2.  ऑपरेिटंग िस�म
3.  यूिटिलटी सॉ�वेयर
4.  ए�ीकेशन सॉ�वेयर
  
Question Number : 5 Question Id : 2549897503 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is Question
Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Which of the following tab is NOT available in OpenOffice 4.0 main menu?
Options :
1.  Convert
2.  Tools
3.  View
4.  File
  
Question Number : 5 Question Id : 2549897503 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is Question
Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
िन� म� से कौन सा टैब ओपन ऑिफस 4.0 मेन मे�ू म� उपल� नही ंहै?
Options :



1.  क�ट�
2.  टू�
3.  �ू
4.  फ़ाइल
  
Question Number : 6 Question Id : 2549897556 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is Question
Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
The word size of the most modern general purpose computers usually is ______.
Options :
1.  64 bits
2.  74 bits
3.  38 bits
4.  16 bits
  
Question Number : 6 Question Id : 2549897556 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is Question
Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
वत�मान म� सामा� उ�े�ो ंके िलए �यु� होने वाले कं�ूटरो ंका श� आमाप (word size) सामा�तः  ______ होता है।
Options :
1.  64 bits
2.  74 bits
3.  38 bits
4.  16 bits
  
Question Number : 7 Question Id : 2549897618 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is Question
Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
A ______ port transmits one bit at a time.
Options :
1.  serial



2.  parallel
3.  line
4.  FireWire
  
Question Number : 7 Question Id : 2549897618 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is Question
Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
______ पोट�, िबट्स की एक �� ीम के �प म� एक बार म� एक िबट को �सा�रत करता है।
Options :
1.  सी�रयल
2.  समानांतर/पैरेलल
3.  लाइन
4.  फायरवायर
  
Question Number : 8 Question Id : 2549897896 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is Question
Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Which of the following icons indicates that a file or folder is in the process of updating in the Dropbox folder on your computer?
Options :

1.  

2.  

3.  



4.  

  
Question Number : 8 Question Id : 2549897896 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is Question
Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
िन� म� से कौन-सा आइकन इंिगत करता है िक आपके कं�ूटर पर ड� ॉपबॉ� फ़ो�र म� कोई फ़ाइल या फ़ो�र अपडेट होने की �ि�या म� है?
Options :

1.  

2.  

3.  

4.  

  
Question Number : 9 Question Id : 2549898715 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is Question
Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Which of the following is considered to be the first supercomputer developed in India, by C-DAC?
Options :
1.  MIHIR
2.  PARAM 8000



3.  PRATYUSH
4.  EKA
  
Question Number : 9 Question Id : 2549898715 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is Question
Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
भारत म� सी-डैक (C-DAC) �ारा िवकिसत पहला सुपर कं�ूटर िन� म� से िकसे माना जाता है?
Options :
1.  िमिहर (MIHIR)
2.  परम 8000 (PARAM 8000)
3.  ��ुष (PRATYUSH)
4.  एका (EKA)
  
Question Number : 10 Question Id : 25498911688 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Which of the following is used to get the processed information i.e, output by submitting input to the computer?
Options :
1.  System bus
2.  Memory
3.  Storage
4.  CPU
  
Question Number : 10 Question Id : 25498911688 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
िन�िल�खत म� से िकसका उपयोग �ोसे�ड जानकारी यानी, कं�ूटर म� इनपुट सबिमट करके आउटपुट �ा� करने के िलए िकया जाता है?
Options :
1.  िस�म बस
2.  मेमरी
3.  भंडारण (Storage)



4.  सीपीयू (CPU)
  
Question Number : 11 Question Id : 25498913747 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
An ______ is an advanced port designed for video cards and 3D accelerators.
Options :
1.  AGV
2.  AGI
3.  AGC
4.  AGP
  
Question Number : 11 Question Id : 25498913747 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
________ एक उ�त पोट� है, िजसे वीिडयो काड� और 3D ए�ेलेरेटर के िलए िडज़ाइन िकया गया है।
Options :
1.  AGV
2.  AGI
3.  AGC
4.  AGP
  
Question Number : 12 Question Id : 25498930209 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
What is the value of the following MS-Excel function, =FLOOR(14,4)?
Options :
1.  12
2.  3
3.  14
4.  144
  



Question Number : 12 Question Id : 25498930209 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
MS-Excel फ़ं�न =FLOOR(14,4) का मान �ा होगा?
Options :
1.  12
2.  3
3.  14
4.  144
  
Question Number : 13 Question Id : 25498930662 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
The ability to do error-free calculations represents the ________ characteristic of the computer. 
Options :
1.  Scalability
2.  Speed
3.  Accuracy
4.  No IQ
  
Question Number : 13 Question Id : 25498930662 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
कं�ूटर �ारा �ुिट रिहत गणनाएं करने की िवशेषता �ा कहलाती है?
Options :
1.  मापनीयता (Scalability)
2.  गित (Speed)
3.  प�रशु�ता (Accuracy)
4.  अनुपल� बु��ल�� (No IQ)
  
Question Number : 14 Question Id : 25498933924 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is



Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Which of the following are two most commonly used types of touch sensors with reference to IoT products?
Options :
1.  Capacitive and Resistive Sensors
2.  Smoke Sensors and LM35 
3.  LM35 and Accelerometer
4.  Accelerometer and Smoke Sensors
  
Question Number : 14 Question Id : 25498933924 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
IoT उ�ादो ंके संदभ� म�, िन�िल�खत म� से कौन से दो सावा�िधक उपयोग िकए जाने वाले टच स�सर ह�?
Options :
1.  कैपेिसिटव और रिज��व स�सर
2.  �ोक स�सर  और  LM35
3.  LM35 और ए�ेलेरोमीटर 
4.  ए�ेलेरोमीटर और �ोक स�सर 
  
Question Number : 15 Question Id : 25498934082 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Each MIDI interface supports how many channels?
Options :
1.  2
2.  16
3.  8
4.  4
  
Question Number : 15 Question Id : 25498934082 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0



��ेक एम.आई.डी.आई. (MIDI) इंटरफ़ेस िकतने चैन� का समथ�न करता है?
Options :
1.  2
2.  16
3.  8
4.  4
  
Question Number : 16 Question Id : 2549896918 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Personal computers can be connected together to form a ______.
Options :
1.  server
2.  super computer
3.  network
4.  enterprise
  
Question Number : 16 Question Id : 2549896918 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
���गत कं�ूटरो ंको एक दूसरे से जोड़ के एक ______ बनाया जा सकता है।
Options :
1.  सव�र
2.  सुपर कं�ूटर
3.  नेटवक�
4.  इ�र�ाइज
  
Question Number : 17 Question Id : 2549897339 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Which of the following file format is used by windows installer during windows installation?



Options :
1.  .avi
2.  .msi
3.  .EC3
4.  .mp3
  
Question Number : 17 Question Id : 2549897339 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
िवंडोज़ इं�ॉलर �ारा िवंडोज़ इं�ॉलेशन के दौरान िन� म� से िकस फाइल फॉम�ट का उपयोग िकया जाता है?
Options :
1.  .avi
2.  .msi
3.  .EC3
4.  .mp3
  
Question Number : 18 Question Id : 2549897757 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
ISDN stands for _______ Services Digital Network.
Options :
1.  Integrated
2.  Inner
3.  Internal
4.  Inbuilt
  
Question Number : 18 Question Id : 2549897757 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
ISDN का अथ� है _______ सिव�सेस िडिजटल नेटवक� ।
Options :
1.  इ��ैिटड



2.  इनर
3.  इ�न�ल
4.  इनिब�
  
Question Number : 19 Question Id : 2549898201 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Application firewall is also known as: 
Options :
1.   Application Gateway 
2.   Application Switch 
3.   Application Security 
4.   Application Hub
  
Question Number : 19 Question Id : 2549898201 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
ए��केशन फ़ायरवॉल को ______ भी कहा जाता है।
Options :
1.  ए��केशन गेटवे
2.  ए��केशन ��च
3.  ए��केशन सुर�ा
4.  ए��केशन हब
  
Question Number : 20 Question Id : 2549898365 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
What will be the output of the following excel formula?
=CEILING.MATH(155,10)
Options :
1.  150



2.  15
3.  160
4.  5
  
Question Number : 20 Question Id : 2549898365 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
िन�िल�खत ए�ेल फॉमू�ला का आउटपुट �ा होगा?
=CEILING.MATH(155,10)
Options :
1.  150
2.  15
3.  160
4.  5
  
Question Number : 21 Question Id : 2549899421 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Printer is a:
Options :
1.  device that takes information from computer and prints it on a paper.
2.  device that stores information.
3.  device that processes the information.
4.  device to scan and print the information on a monitor.
  
Question Number : 21 Question Id : 2549899421 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
ि�ंटर एक:
Options :
1.  एसा उपकरण है, जो कं�ूटर से जानकारी लेता है और उसे एक कागज पर ि�ंट करता है।
2.  एसा उपकरण है, जो जानकारी सं�हीत करता है।



3.  एसा उपकरण है, जो सूचना को संसािधत करता है।
4.  एसा उपकरण है, जो मॉिनटर पर जानकारी को �ैन और ि�ंट करता है।
  
Question Number : 22 Question Id : 2549899556 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
_____ printers essentially spray ink onto paper through a nozzle in microscopic droplets.
Options :
1.  Dot matrix
2.  Mechanical
3.  Laser
4.  Inkjet 
  
Question Number : 22 Question Id : 2549899556 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
_____ ि�ंटर वा�व म� एक नोजल के मा�म से सू� िछंटो (बंूदो)ं के �प म� कागज पर �ाही िछड़कते ह�।
Options :
1.  डॉट मैिट� �
2.  मैकेिनकल 
3.  लेज़र
4.  इंकजेट
  
Question Number : 23 Question Id : 25498910805 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
______ is a device found on a computer printer that accepts track of paper and feeds them through the machine one by one.
Options :
1.  Sheet feeder
2.  Print preview 
3.  Print spooler



4.  Print taper
  
Question Number : 23 Question Id : 25498910805 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
______ एक कं�ूटर ि�ंटर पर पाए जाने वाले िडवाइस ह� जो कागज का ट� ैक �ीकार करते ह� और उ�� मशीन के मा�म से एक-एक करके फ़ीड करते ह�।
Options :
1.  शीट फीडर
2.  ि�ंट �ी�ू  
3.  ि�ंट �ूलर
4.  ि�ंट टेपर
  
Question Number : 24 Question Id : 25498911102 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Devices such as monitors, printers, and keyboard, that connected to the computers are collectively called as ______.
Options :
1.  Wireless Devices
2.  Input Devices
3.  Peripheral Devices
4.  Network
  
Question Number : 24 Question Id : 25498911102 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
कं�ूटर से जुड़े मॉिनटर, ि�ंटर और कीबोड� जैसे उपकरणो ंको सामूिहक �प से ______ कहा जाता है।
Options :
1.  वायरलेस िडवाइस
2.  इनपुट िडवाइस
3.  पे�रफेरल िडवाइस
4.  नेटवक�



  
Question Number : 25 Question Id : 25498913364 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
______ compression technique can NOT completely recover original data.
Options :
1.  Dirty
2.  Lossy
3.  Lossless
4.  Clean
  
Question Number : 25 Question Id : 25498913364 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
______ संपीड़न तकनीक पूरी तरह से मूल डेटा पुन�ा�� नही ंकर सकता है।
Options :
1.  डट� (Dirty)
2.  लॉसी (Lossy)
3.  लॉसलेस (Lossless)
4.  �ीन (Clean)
  
Question Number : 26 Question Id : 25498913773 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
______ key algorithms uses one key for encryption and another for decryption.
Options :
1.  Secret 
2.  Personal
3.  Shared
4.  Public
  
Question Number : 26 Question Id : 25498913773 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is



Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
______ कंुजी ए�ो�रथम ए����शन के िलए िकसी एक का और िडि��शन के िलए िकसी दूसरी कंुजी का उपयोग करता है।
Options :
1.  गु� (सी�ेट)
2.  वैय��क (पस�नल)
3.  सहभाजी (शेअड�)
4.  साव�जिनक (प��क)
  
Question Number : 27 Question Id : 25498913911 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
In IP address 192.168.1.255, 255 is assigned as:
Options :
1.  device address
2.  automatically assigned network address
3.  gateway address
4.  broadcast address
  
Question Number : 27 Question Id : 25498913911 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
IP   एड� ेस 192.168.1.255 म� 255 को िकस �कार असाइन िकया गया है?
Options :
1.  िडवाइस एड� ेस
2.  �चािलत �प से असाइन िकया गया नेटवक�  एड� ेस
3.  गेटवे एड� ेस
4.  �ॉडका� एड� ेस
  
Question Number : 28 Question Id : 25498918588 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0



Correct Marks : 1 Wrong Marks : 0
When using WINDOWS, what are the general steps to Install an OS using VMWare?
Options :
1.  (1) Create New virtual machine using Windows OS (2) Select OS and its version (3) Locate ISO file of that OS (4) Install OS (follows
screens) (5) OK 
2.  (1) Create New virtual machine using Linux OS (2) Select OS and its version (3) Locate ISO file of that OS (4) Install OS (follows screens)
(5) OK 
3.  (1) Install VMWare (2) Click New virtual machine (3) Select OS and its version (4) Locate ISO file of that OS (5) Install OS (follows
screens) (6) OK
4.  (1) Install VMWare (2) Click New virtual machine (3) Select OS and its version (4) Install OS (follows screens) (5) OK
  
Question Number : 28 Question Id : 25498918588 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
WINDOWS का उपयोग करते समय, VMWare का उपयोग करके OS �थािपत करने के सामा� चरण �ा ह�?
Options :
1.  (1) Windows OS का �योग कर Create New virtual machine पर ��क कर�  (2) OS और इसके सं�रण का चयन कर�  (3) इस OS की ISO फ़ाइल
ढँूढ�  (4) OS �थािपत कर�  (�ीन का अनुसरण कर� ) (5) OK
2.  (1) Linux OS का �योग कर Create New virtual machine पर ��क कर�  (2) OS और इसके सं�रण का चयन कर�  (3) इस OS की ISO फ़ाइल ढँूढ�
(4) OS �थािपत कर�  (�ीन का अनुसरण कर� ) (5) OK
3.  (1) VMWare �थािपत कर�  (2) New virtual machine पर ��क कर�  (3) OS और इसके सं�रण का चयन कर�  (4) इस OS की ISO फ़ाइल ढँूढ�  (5) OS
�थािपत कर�  (�ीन का अनुसरण कर� ) (6) OK
4.  (1) VMWare �थािपत कर�  (2) New virtual machine पर ��क कर�  (3) OS और इसके सं�रण का चयन कर�  (4) OS �थािपत कर�  (�ीन का
अनुसरण कर� ) (5) OK
  
Question Number : 29 Question Id : 25498924295 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Operating system resides:
Options :
1.  HDD
2.  ROM
3.  PROM



4.  EEPROM
  
Question Number : 29 Question Id : 25498924295 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
ऑपरेिटंग िस�म ______ रहता है।
Options :
1.  HDD
2.  ROM
3.  PROM
4.  EEPROM
  
Question Number : 30 Question Id : 25498924981 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Which of the following is NOT a type of redundancy used in image compression?
Options :
1.  Psycho-visual Redundancy
2.  Inter-pixel Redundancy
3.  Time Redundancy 
4.  Coding redundancy
  
Question Number : 30 Question Id : 25498924981 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
िन�िल�खत म� से �ा छिव संपीड़न म� उपयोग की जाने वाली अितरेकता का एक �कार नही ंहै?
Options :
1.  साइको-िवजुअल अितरेकता
2.  इंटर-िप�ल अितरेकता
3.  समय अितरेकता
4.  कोिडंग अितरेकता



  
Question Number : 31 Question Id : 2549896531 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
______ are used to identify a user who returns to a website.
Options :
1.  Cookies
2.  Plug-ins
3.  Scripts
4.  ASPs
  
Question Number : 31 Question Id : 2549896531 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
______ का उपयोग िकसी वेबसाइट पर लौटने वाले उपयोगकता� की पहचान करने के िलए िकया जाता है।
Options :
1.  कूकीज़ (Cookies)
2.  �ग-इ� (Plug-ins)
3.  ���्स (Scripts)
4.  ASPs
  
Question Number : 32 Question Id : 2549897105 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
In Gmail, deals and offers are part of the ______ tab.
Options :
1.  updates
2.  promotions
3.  forums
4.  primary
  
Question Number : 32 Question Id : 2549897105 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is



Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Gmail म� सौदे और ��ाव ______ टैब का िह�ा ह�।
Options :
1.  अपडेट्स
2.  �मोश�
3.  फौर�
4.  �ाइमरी
  
Question Number : 33 Question Id : 2549897498 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
What is the shortcut key used to insert hyperlink in MS-PowerPoint 2016?
Options :
1.  Alt+F1
2.  Alt+F2
3.  Ctrl+K
4.  Ctrl+B
  
Question Number : 33 Question Id : 2549897498 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
MS-PowerPoint 2016 म� हाइपरिलंक �िव� करवाने के िलए उपयोग की जाने वाली शॉट�कट कंुजी �ा है?
Options :
1.  Alt+F1
2.  Alt+F2
3.  Ctrl+K
4.  Ctrl+B
  
Question Number : 34 Question Id : 2549897953 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0



Which of the following is a free app developed by Nolan Amy that can be used on IOS or Android operating system for pre-assessments, checks
for understanding, polls or class surveys, tickets out the door, TCAP review, etc?
Options :
1.  Plickers
2.  Flickers
3.  Scanners
4.  Pluckers
  
Question Number : 34 Question Id : 2549897953 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
िन�िल�खत म� से कौन सा नोलन एमी �ारा िवकिसत एक ऐसा िनः शु� ऐप है िजसका उपयोग IOS अथवा एंड� ॉइड ऑपरेिटंग िस�म पर पूव�-मू�ांकन, समझ
की जांच, मत या वग� सव��ण, बाहर से िटकट लेने, TCAP समी�ा आिद के िलए िकया जा सकता है?
 
Options :
1.  ��कस� (Plickers)
2.  ��लकस� (Flickers)
3.  �ैनस� (Scanners)
4.  �कस� (Pluckers)
  
Question Number : 35 Question Id : 2549898009 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
What is the maximum per transaction limit for sending money in BHIM payment interface as of January 2022?
Options :
1.  20,000
2.  100,000
3.  50,000
4.  25,000
  
Question Number : 35 Question Id : 2549898009 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0



Correct Marks : 1 Wrong Marks : 0
जनवरी 2022 तक की ��थित के अनुसार, भीम (BHIM) पेम�ट इंटरफ़ेस म� पैसे भेजने के िलए �ित ट� ांजे�न (transaction) की अिधकतम सीमा �ा है?
Options :
1.  20,000
2.  100,000
3.  50,000
4.  25,000
  
Question Number : 36 Question Id : 2549898105 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Which of the following types of pie chart contains more than one data series at a time in MS-Excel 2016?
 
Options :
1.  Doughnut
2.  Clustered
3.  Stacked
4.  Bar
  
Question Number : 36 Question Id : 2549898105 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
MS-Excel 2016 म�, िन�िल�खत म� से िकस �कार के पाई चाट� म� एक समय म� एक से अिधक डेटा �ंृखला होती है?
Options :
1.  डोनट (Doughnut)
2.  �सटड� (Clustered)
3.  �ै�ड (Stacked)
4.  बार (Bar)
  
Question Number : 37 Question Id : 2549898120 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0



Which of the following statements is INCORRECT with respect to surface chart in MS-PowerPoint 2007?
Options :
1.  Useful when you want to find optimum combinations between two sets of data.
2.  Uses chart when both categories and data series are numeric values.
3.  This type of chart requires four series of values in the correct order (open, high, low, and then close).
4.  3-D surface charts show trends in values across two dimensions in a continuous curve.
  
Question Number : 37 Question Id : 2549898120 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
MS-PowerPoint 2007 म�, सफ� स चाट� के मामले म� कौन-सा कथन गलत है?
Options :
1.  तब उपयोगी जब आप डेटा के दो सेटो ंके बीच इ�तम संयोजन खोजना चाहते ह�।
2.  चाट� का �योग िकया जाता है जब दोनो,ं वग� एवं डेटा की �ंृखलाओ ंका मू� सं�ा�क होता है।
3.  इस �कार के चाट� म� सही �म म� मू�ो ंके चार �ंृखलाओ ं(खुला, उ�, िन�, और िफर बंद) की आव�कता पड़ती है।
4.  3-D सफ� स चाट�, एक सतत व� म� दो आयामो ंके मू�ो ंम� ट� �ड्स िदखाते ह�।
  
Question Number : 38 Question Id : 2549899156 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
To conduct voice chat with your family and friends, you need to use ______.
Options :
1.  antivirus
2.  Google Meet
3.  plickers
4.  MS Word
  
Question Number : 38 Question Id : 2549899156 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
अपने प�रवार और िम�ो ंके साथ वॉइस चैट करने के िलए आपको ______ का उपयोग करना होगा।
Options :



1.  एंटीवायरस
2.  गूगल मीट (google meet)
3.  ��कस� (plickers)
4.  MS Word
  
Question Number : 39 Question Id : 2549899197 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
______ is a type of personal website where articles are regularly posted.
Options :
1.  Google
2.  Web log
3.  Word processor
4.  Microsoft outlook express
  
Question Number : 39 Question Id : 2549899197 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
______ एक �कार की ���गत वेब साइट है जहाँ िनयिमत �प से लेख पो� िकए जाते ह�।
Options :
1.  गूगल (Google)
2.  वेब लॉग (Web log)
3.  वड� �ोसेसर (Word processor)
4.  माइ�ोसॉ� आउटलुक ए��ेस (Microsoft outlook express)
  
Question Number : 40 Question Id : 25498910487 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Which of the following options is used to capitalize the first letter of a sentence and leave all other letters as lowercase in MS-Word 2016
document?
Options :



1.  Paragraph Case
2.  Section Case
3.  Sentence Case
4.  Toggle Case
  
Question Number : 40 Question Id : 25498910487 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
MS-Word 2016 डॉ�ुम�ट म�, िन�िल�खत म� से िकस िवक� का �योग वा� के पहले अ�र को बड़े अ�रो ं(capital) म� िलखने और अ� सभी अ�रो ंको
लोअरकेस के �प म� छोड़ने के िलए िकया जाता है?
Options :
1.  पैरा�ाफ केस (Paragraph Case) 
2.  से�न केस (Section Case)
3.  स��ट�स केस (Sentence Case) 
4.  टॉगल केस (Toggle Case) 
  
Question Number : 41 Question Id : 25498910654 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
In computer graphics, we can adjust the shape of the line ends to give them a better appearance by using:
Options :
1.  line spacing
2.  more dots
3.  square caps
4.  line caps
  
Question Number : 41 Question Id : 25498910654 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
कं�ूटर �ािफ� म�, हम िन� म� से िकसकी सहायता से लाइन के आकार को समायोिजत करके उ�� बेहतर उप��थित देने के िलए समायोिजत कर सकते ह�?
Options :



1.  लाइन � पेिसंग
2.  अिधक िबंदु
3.  चौकोर कै�
4.  लाइन कै�
  
Question Number : 42 Question Id : 25498910662 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Which of the following pagination controls in the Line and Page Breaks tab places at least two lines of a paragraph at the top or bottom of a page
in MS-Word 2019?
Options :
1.  Widow/Orphan control
2.  Page break before
3.  Keep with next
4.  Keep lines together
  
Question Number : 42 Question Id : 25498910662 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
MS-Word 2019 म�, लाइन और पेज �े� टैब म� िन�िल�खत म� से कौन-सा पेिजनेशन िनयं�ण (pagination controls) एक पेज के ऊपर या नीचे पैरा�ाफ की
कम से कम दो लाइनो ंको रखता है?
Options :
1.  िवडो/ऑफ़� न कंट� ोल (Widow/Orphan control)
2.  पेज �ेक िबफोर (Page break before)
3.  कीप िवद ने� (Keep with next)
4.  कीप लाइ� टुगेदर (Keep lines together)
  
Question Number : 43 Question Id : 25498910686 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
A/an ______ section break lets you start a new section on the next odd-numbered page in MS-Word 2016.
Options :



1.  next page
2.  continuous
3.  even page
4.  odd page
  
Question Number : 43 Question Id : 25498910686 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
MS Word 2016 म�, ______ से�न �ेक आपको अगले िवषम सं�ा वाले पेज पर एक नया से�न शु� करने देता है।
Options :
1.  ने� पेज
2.  कंटी�ूअस
3.  इवन पेज
4.  ऑड पेज
  
Question Number : 44 Question Id : 25498911444 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Which of the following options in MS-Word 2010 is NOT present in the proofing ribbon?
Options :
1.  Spelling & Grammar
2.  Research
3.  New comment
4.  Word count
  
Question Number : 44 Question Id : 25498911444 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
MS Word 2010 म�, अशु�� जांच (�ूिफंग) प�ी म� िन� म� से कौन सा िवक� मौजूद नही ंहै?
Options :
1.  वत�नी और �ाकरण (�ेिलंग एंड �ामर)



2.  अनुसंधान (�रसच�)
3.  नई िट�णी (�ू कम�ट)
4.  श� गणना (वड� काउंट)
  
Question Number : 45 Question Id : 25498911861 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
In MS-Word 2007 revisions, changes, and corrections are typically shown in the ______ near or in the margin of the page.
Options :
1.  ruler
2.  header
3.  footer
4.  balloons
  
Question Number : 45 Question Id : 25498911861 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
MS-Word 2007 म� पुनरी�ण, प�रवत�न और सुधार आमतौर पर पृ� के पास या मािज�न म� ______ म� िदखाए जाते ह�।
Options :
1.  �लर
2.  हैडर
3.  फूटर
4.  बैलू�
  
Question Number : 46 Question Id : 25498911934 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Raghu wants to create a table in MS-Word 2013 with five columns; which of the following option must he choose?
Options :
1.  Quick tables
2.  AutoFit contents



3.  AutoFit to window
4.  Insert Table -> Number of columns
  
Question Number : 46 Question Id : 25498911934 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
रघु MS-Word 2013 म� पांच कॉलम वाली तािलका बनाना चाहता है, उसे िन�िल�खत म� से कौन सा िवक� चुनना चािहए?
Options :
1.  ��क टेब� 
2.  ऑटोिफट कंट�ट्स
3.  ऑटोिफट टू िवंडो
4.  इ�ट� टेबल -> नंबर ऑफ कॉल�
  
Question Number : 47 Question Id : 25498918967 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Which of the following shortcuts can be used to see the Print Preview of the MS-Word 2019 document?
Options :
1.  CTRL+F1
2.  CTRL+F4
3.  CTRL+F3
4.  CTRL+F2
  
Question Number : 47 Question Id : 25498918967 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
MS-Word 2019 डॉ�ुम�ट का ि�ंट ि��ू देखने के िलए िन� म� से िकस शॉट�कट का उपयोग िकया जा सकता है?
Options :
1.  CTRL+F1
2.  CTRL+F4
3.  CTRL+F3



4.  CTRL+F2
  
Question Number : 48 Question Id : 25498919244 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Reena wants to change the font style of the return address of an envelope during mail merge process in MS-Word 2019. Which of the following
options are used?
Options :
1.  Mailings
2.  References
3.  Page layout
4.  Design
  
Question Number : 48 Question Id : 25498919244 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
रीना MS-Word 2019 म�, मेल मज� (mail merge) �ि�या के दौरान एक िलफाफे (envelope) के �रटन� एड� ेस की फ़ॉ� शैली को बदलना चाहती है। िन�िल�खत
म� से िकस िवक� का उपयोग िकया जाता है?
Options :
1.  मेिलंग (Mailings)
2.  रेफरे�ेस (References)
3.  पेज लेआउट (Page layout)
4.  िडज़ाइन (Design)
  
Question Number : 49 Question Id : 25498924863 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Which of the following is the correct order of action to create a pivot table in MS-Excel 2016?
Options :
1.  Menu > PivotTable > Insert > Create PivotTable > Range
2.  Menu > PivotTable > Insert > Range > Create PivotTable
3.  Menu > Insert > PivotTable > Create PivotTable > Select table or Range



4.  Menu > PivotTable > Create PivotTable > Insert > Range
  
Question Number : 49 Question Id : 25498924863 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
MS Excel 2016 म�, िपवोट टेबल बनाने के िलए िन� म� से कौन सा ि�या का सही �म है?
Options :
1.  Menu > PivotTable > Insert > Create PivotTable > Range
2.  Menu > PivotTable > Insert > Range > Create PivotTable
3.  Menu > Insert > PivotTable > Create PivotTable > Select table or Range
4.  Menu > PivotTable > Create PivotTable > Insert > Range
  
Question Number : 50 Question Id : 25498925316 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
What are the steps to open new readymade templates in MS-Word 2010?
Options :
1.  File (office Button) – open – select all word template from dialouge box
2.  Cannot open readymade templates
3.  File (office Button) – New – Sample Template – Select any template from available templates
4.  File – Open – select Templates
  
Question Number : 50 Question Id : 25498925316 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
MS-Word 2010 म�, नया पूव�-िनिम�त टे��ेट खोलने के िलए िन� म� से िकन चरणो ंका अनुसरण करना होगा?
Options :
1.  फ़ाइल (ऑिफस बटन) – ओपन - डायलॉग बॉ� से सभी वड� टे�लेट चुन�
2.  पूव�-िनिम�त टे��ेट नही ंखोले जा सकते ह� 
3.  फ़ाइल (ऑिफस बटन) – �ू - स�पल टे�लेट - उपल� टे�लेट्स म� से कोई भी टे�लेट चुन�
4.  फ़ाइल – ओपन – टे�लेट चुन�



  
Question Number : 51 Question Id : 25498925336 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Which of the following ribbon navigation short cut key is used to go to Layout tab in MS-Word 2019?                        
Options :
1.  Alt + P
2.  Atl + N
3.  Alt + H
4.  Alt + G
  
Question Number : 51 Question Id : 25498925336 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
MS-Word 2019 म�, लेआउट टैब पर जाने के िलए िन� म� से िकस �रबन नेिवगेशन शॉट�कट की (key) का उपयोग िकया जाता है?
Options :
1.  Alt + P
2.  Atl + N
3.  Alt + H
4.  Alt + G
  
Question Number : 52 Question Id : 25498934484 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Which of the following is capable of playing audio and video streams?
Options :
1.  Audio player
2.  MP3 player
3.  Media player
4.  Audio CD player
  
Question Number : 52 Question Id : 25498934484 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is



Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
िन� म� से कौन-सा, ऑिडयो और वीिडयो �� ीम को चलाने (playing) म� स�म है?
Options :
1.  ऑिडयो �ेयर
2.  MP3 �ेयर
3.  मीिडया �ेयर
4.  ऑिडयो CD �ेयर
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Question Id : 25498920875 Question Type : COMPREHENSION Sub Question Shuffling Allowed : Yes Group Comprehension
Questions : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Question Numbers : (53 to 57)
Read the given passage and answer the questions.

Hanumanthappa

One bright June morning I was reading the newspaper. That day the Secondary School Leaving Certificate results had been published. The list of



the rank holders and their photographs took up almost the entire front page. Of all the photographs, one boy's snapshot caught my attention. He
looked sickly and pale, but there was a sparkle in his eyes. I read that his name was Hanumanthappa and that he had secured the eighth rank.

The next day, his photograph was published again with an interview. I learnt that Hanumanthappa was a coolie's son, the oldest of five children.
They belonged to a tribal group. He was unable to study further, because he lived in a village and his father, the sole breadwinner, earned only
Rs. 40 a day.

Hanumanthappa's postal address was provided in the interview. I immediately wrote to him saying that I was interested in meeting him and asked
whether he could come to Bangalore. I added that I would pay for his travel and some clothes. Within four days I received a reply, thanking me
for the letter and expressing his willingness to come and meet me. Immediately, I sent him some money and details of my office address.

When he finally arrived in our office, I got straight to the point. 'Do you want to study further? We would like to support you. We will pay your
fees for any course of study you wish to take up.' He did not answer. My senior colleague interrupted with a smile. 'Let the boy understand what
you are suggesting. He can give his answer at the end of the day.'

When Hanumanthappa was ready to return home, he said in a low and steady tone, 'Madam, I want to continue my studies at the Teacher's
Training College in Bellary. That is the one nearest to my village.' I agreed instantly but spoke to him a little more to find out whether there was
any other course he would like to choose. The boy, however, seemed to know exactly what he wanted.

I prayed that God would continue to bestow the best on Hanumanthappa and his family.
Sub questions
 
Question Number : 53 Question Id : 25498920876 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
What was special about the day described in the first paragraph?
Options :
1.  The author had a meeting with one of the rank holders.
2.  The newspaper was delivered much before the usual time.
3.  The Secondary School Leaving Certificate results had been declared with photographs of the rank holders.
4.  There was a full page advertisement about Teacher Training Colleges of Karnataka.
 
Question Number : 54 Question Id : 25498920877 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
What inspired the author to help Hanumanthappa for further studies?
Options :



1.  Hanumanthappa's bright and sparkling eyes in his weak and pale face attracted her.
2.  Hanumanthappa had stated in an interview that he did not want to study further because his father was very poor.
3.  Hanumanthappa had written to the author for help.
4.  The author wanted to help the poor but intelligent rank holder
 
Question Number : 55 Question Id : 25498920878 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Hanumanthappa wanted to join the Teacher's Training College at Bellary because
Options :
1.  he did not have any ambition for his future.
2.  he wanted to join a course that would take a long time to complete.
3.  wanted to burden the author by joining an expensive course.
4.  he did not want to travel very far from his village.
 
Question Number : 56 Question Id : 25498920879 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Choose the alternative that is NOT correct.
What do we learn about the author from this passage?
Options :
1.  She wanted to know what was happening in the country.
2.  She admired other people’s intelligence and hard work.
3.  She was kind and helped needy people.
4.  She forced other people to accept her decisions.
 
Question Number : 57 Question Id : 25498920880 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Based on the passage, which one of the following statements is true of Hanumanthappa's character?
Options :
1.  He was honest and sincere in all his work.
2.  He was  prompt and precise in his correspodence.



3.  He was capable of taking firm decisions.
4.  He was always eager to meet new people.
  
Question Id : 25498920875 Question Type : COMPREHENSION Sub Question Shuffling Allowed : Yes Group Comprehension
Questions : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Question Numbers : (53 to 57)
िदए गए ग�ांश को पढ़�  और उसके आधार पर ��ो ंके उ�र द�।

हनुमानथ�ा

जून की एक चमकदार सुबह म� समाचार प� पढ़ रही थी। उस िदन मा�िमक �ूल लीिवंग सिट�िफकेट की परी�ा का प�रणाम �कािशत िकया गया था। र�क
धारको ंकी सूची और उनकी त�ीरो ंने लगभग पूरे सामने वाले पृ� को भर िदया था। सभी त�ीरो ंम� से एक लड़के के फोटो ने मेरा �ान खीचंा। वह बीमार और
कमजोर लग रहा था, लेिकन उसकी आंखो ंम� एक चमक थी। म��ने पढ़ा िक उसका नाम हनुमानथ�ा था और उसने आठवी ंर�क हािसल की थी।

अगले िदन, उसकी त�ीर एक लेख के साथ िफर से �कािशत �ई थी। मुझे पता लगा िक हनुमानथ�ा एक कुली का बेटा है, जो पांच भाई-बहनो ंम� सबसे बड़ा
है। वे एक जनजातीय समूह से थे। वह आगे अ�यन करने म� असमथ� था, �ों�िक वह एक गांव म� रहता था और उसके िपता, एकमा� कमाने वाले, िदन म� केवल
40 �पये कमाते थे।

हनुमानथ�ा का डाक का पता उस म�  िदया गया था। म��ने तुरंत उसे यह कहते �ए िलखा िक मुझे उससे िमलने की इ�ा है और पूछा िक �ा वह ब�गलोर आ
सकता है। म��ने कहा िक म� उसकी या�ा और कपड़ो ंके िलए पैसे दंूगी। चार िदनो ंके भीतर, प� के िलए मुझे ध�वाद और आने और मुझसे िमलने की इ�ा
�� करते �ए मुझे उ�र िमला। तुरंत, म��ने उसे कुछ �पये और मेरे काया�लय के पते के िववरण भेजे।

जब वह अंततः  हमारे काया�लय प�ंचा, तो म� सीधे ही अपनी बात पर आ गई। '�ा तुम आगे पढ़ना चाहते हो?' हम तु�ारी सहायता करना चाहते ह�। तुम पढ़ाई
का जो भी िवषय चुनोगे, उसके िलए हम फीस का भुगतान कर� गे।' उसने जवाब नही ंिदया। मेरे व�र� सहयोगी ने मु�ुरा के हम� रोका। 'लड़के को समझने द�  िक
आप �ा सुझाव दे रही ह�। वह शाम तक अपना जवाब दे सकता है।

जब हनुमानथ�ा घर लौटने के िलए तैयार था, उसने धीमे और ��थर �र म� कहा, 'मैडम, म� बे�ारी म� टीचर ट� े िनंग कॉलेज म� अपनी पढ़ाई जारी रखना चाहता
�ं। यह मेरे गांव के सबसे नजदीक है।' म� तुरंत सहमत हो गई लेिकन यह जानने के िलए उससे थोड़ी और बात की िक �ा वह कोई अ� कोस� चुनना चाहता है।
हालांिक, लड़का जानता था िक वह �ा चाहता था।

म��ने �ाथ�ना की िक भगवान हनुमानथ�ा और उनके प�रवार को सव��े� �दान करना जारी रख�।
Sub questions
 
Question Number : 53 Question Id : 25498920876 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0



Correct Marks : 1 Wrong Marks : 0
पहले पैरा�ाफ म� विण�त िदन के बारे म� �ा िवशेष था?
Options :
1.   ले�खका की एक र�क धारक के साथ बैठक �ई।
2.  समाचार प� सामा� िदनो ंकी तुलना म� काफी ज�ी िदया गया था।
3.  मा�िमक �ूल छोड़ने के �माणप� का प�रणाम र�क धारको ंकी त�ीरो ंके साथ घोिषत िकया गया था।
4.  कना�टक के टीचर ट� े िनंग कॉलेज के बारे म� एक पूरे पेज का िव�ापन था।
 
Question Number : 54 Question Id : 25498920877 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
आगे के अ�यन के िलए हनुमानथ�ा की मदद करने के िलए ले�खका को िकस चीज ने �े�रत िकया?
Options :
1.  हनुमानथ�ा के कमजोर और िन�ेज चेहरे म� उसकी उ�ल और चमकदार आंखो ंने उ�� आकिष�त िकया।
2.  हनुमानथ�ा ने एक सा�ा�ार म� कहा था िक वह आगे पढ़ना नही ंचाहता है �ों�िक उसके िपता ब�त गरीब ह�।
3.  हनुमानथ�ा ने मदद के िलए ले�खका को िलखा था।
4.  ले�खका गरीब लेिकन बु��मान र�क धारक की सहायता करना चाहती थी।
 
Question Number : 55 Question Id : 25498920878 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
हनुमानथ�ा बे�ारी म� टीचस� ट� े िनंग (िश�क �िश�ण) कॉलेज म� �वेश लेना चाहता था �ों�िक
Options :
1.  उसके भिव� के िलए उसकी कोई मह�ाकां�ा नही ंथी।
2.  वह ऐसा पाठ् य�म पढ़ना चाहता था िजसे पूरा करने म� �ादा समय लगे।
3.  वह िकसी महंगे पा��म म� शािमल होकर ले�खका पर बोझ डालना चाहता था।
4.  वह अपने गाँव से ब�त दूर नही ंजाना चाहता था।
 
Question Number : 56 Question Id : 25498920879 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
उस िवक� को चुन� जो सही नही ंहै।



इस ग�ांश से ले�खका के बारे म� हम� �ा पता चलता है?
Options :
1.  वह जानना चाहती थी ंिक देश म� �ा हो रहा था।
2.  वह दूसरो ंकी अ� और कड़ी मेहनत की �शंसा करती थी।
3.  वह दयालु थी ंऔर ज़�रतमंद लोगो ंकी मदद करती थी।ं
4.  उ�ों�ने दुसरे लोगो ंको अपने फैसले को �ीकार करने के िलए मजबूर कर िदया।
 
Question Number : 57 Question Id : 25498920880 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
अनु�ेद के आधार पर, हनुमानथ�ा के च�र� के बारे म� िन� म� से कौन सा कथन स� है?
Options :
1.  वह अपने सभी काय� ईमानदारी और िवन�ता से करता था।
2.  वह ��रत और सटीक प�ाचार करता था।
3.  वह ठोस िनण�य लेने म� स�म था।
4.  वह सदैव नए लोगो ंसे िमलने को उ�ुक रहता था।
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Question Number : 58 Question Id : 25498914226 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
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Correct Marks : 1 Wrong Marks : 0
What approximate value should come in place of the question mark (?) in the following question? (rounded off to nearest tens)

1548.45 + 3065.15 ÷ 15.058 = ?
Options :
1.  1700
2.  1650
3.  1840
4.  1750
  
Question Number : 58 Question Id : 25498914226 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
िन�िल�खत �� म� �� िच� (?) के �थान पर अनुमािनत मान �ा होना चािहए? (िनकटतम दशमलव �थान तक पूण� करे)

1548.45 + 3065.15 ÷ 15.058 = ?
Options :
1.  1700
2.  1650
3.  1840
4.  1750
  
Question Number : 59 Question Id : 25498914230 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0

Options :

1.  



2.  

3.  

4.  

  
Question Number : 59 Question Id : 25498914230 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0

Options :

1.  

2.  

3.  

4.  

  
Question Number : 60 Question Id : 25498914231 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0

Options :

1.  

2.  



3.  

4.  

  
Question Number : 60 Question Id : 25498914231 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0

Options :

1.  

2.  

3.  

4.  

  
Question Number : 61 Question Id : 25498914366 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0

Options :

1.  



2.  

3.  

4.  

  
Question Number : 61 Question Id : 25498914366 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
एक अ�ी तरह फ� टी �ई 52 प�ो ंकी ग�ी से एक प�ा �म रिहत िनकाला जाता है। प�े का काला बादशाह होने की �ा संभावना है?
Options :

1.  

2.  

3.  

4.  

  
Question Number : 62 Question Id : 25498928777 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0



Options :

1.  

2.  

3.  

4.  

  
Question Number : 62 Question Id : 25498928777 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0

Options :

1.  

2.  

3.  

4.  

  



Question Number : 63 Question Id : 25498928782 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0

Options :

1.  

2.  

3.  

4.  

  
Question Number : 63 Question Id : 25498928782 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0

Options :



1.  

2.  

3.  

4.  
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Display Number Panel : Yes
Enable Mark as Answered Mark for Review and Clear Response : Yes
Maximum Instruction Time : 0
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Question Shuffling Allowed : Yes
  
Question Number : 64 Question Id : 25498910133 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0



Correct Marks : 1 Wrong Marks : 0
Select the option that is related to the third term in the same way as the second term is related to the first term.

Dum Dum : Kolkata :: Palam : ?
Options :
1.  Kerala
2.  Delhi
3.  Chennai
4.  Mumbai
  
Question Number : 64 Question Id : 25498910133 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
उस िवक� को चुने जो तीसरे श� से ठीक उसी तरह से संबंिधत है िजस तरह दूसरा श� पहले श� से संबंिधत है।

डम डम : कोलकाता :: पालम : ?
Options :
1.  केरल
2.  िद�ी
3.  चे�ई
4.  मंुबई
  
Question Number : 65 Question Id : 25498912865 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Find out how many such pairs of letters are there in the given word each of which has as many letters between them in the word as in the English
alphabet.

DECORATE
Options :
1.  Nil
2.  One
3.  Two



4.  Three
  
Question Number : 65 Question Id : 25498912865 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
िदये गये श� म� अ�रो ंके ऐसे िकतने जोड़े ह�, िजनम� से ��ेक के बीच उतने ही अ�र ह� िजतने अं�ेजी वण�माला म� उनके बीच ह�?

DECORATE
Options :
1.  शू�
2.  एक
3.  दो
4.  तीन
  
Question Number : 66 Question Id : 25498912898 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Find out which of the letter-series follows the given rule:

Number of letters skipped in between adjacent letters in the series doubles every time.
Options :
1.  ADIPY
2.  BDGLU
3.  EGJOF
4.  GJNSY
  
Question Number : 66 Question Id : 25498912898 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
पता लगाएं िक कौन सी अ�र-�ंृखला िदए गए िनयम का पालन करती है।

एक �ंृखला म� िनकटवत� अ�रो ंके बीच म� छोड़े गये अ�रो ंकी सं�ा ��ेक बाद दोगुना हो जाती है।
Options :



1.  ADIPY
2.  BDGLU
3.  EGJOF
4.  GJNSY
  
Question Number : 67 Question Id : 25498919603 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Select the alternative with the most appropriate description about these three words.

Chain : Link : Bridge
Options :
1.  They all have books.
2.  They are related with ornaments.
3.  They join two parts.
4.  The terms are related with prison.
  
Question Number : 67 Question Id : 25498919603 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
इन तीन श�ो ंके संबंध म� सबसे उिचत िववरण वाले िवक� का चयन कर�।

�ंृखला : िलंक : ि�ज
Options :
1.  उनके पास सभी िकताब� ह�।
2.  ये गहने से संबंिधत ह�।
3.  ये दो भागो ंको जोड़ते ह�।
4.  ये श� जेल से संबंिधत ह�।
  
Question Number : 68 Question Id : 25498919730 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0



A bowl of sweets was placed on a table to be distributed among three brothers- Rajan, Sajal and Karan. Rajan arrived first and ate what he
thought was his share of sweets and left. Then, Sajal arrived. He thought that he was the first one to arrive and ate the number of sweets and he
had his share and left. Lastly, Karan arrived. He again thought he was the first one to arrive and he took what he thought was his share. If 16
sweets are left in the bowl finally, how many sweets did the bowl contain initially?
Options :
1.  27
2.  36
3.  48
4.  54
  
Question Number : 68 Question Id : 25498919730 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
तीन भाइयो-ं राजन, सजल और करण के बीच िवत�रत करने के िलए एक मेज पर िमठाई का एक कटोरा रखा गया था। राजन पहले प�ंचा और उसने िमठाई का
वह िह�ा खा िलया जो उसने सोचा िक उसका था और शेष छोड़ िदया। िफर, सजल प�ंचा। उसने सोचा िक वह आने वाला पहला ��� है और उसने िमठाई
का वह िह�ा खा िलया जो उसने सोचा िक उसका था और शेष छोड़ िदया। अंत म�, करण प�ंचा। उसने भी सोचा िक वह आने वाला पहला ��� है और उसने
िमठाई का वह िह�ा खा िलया जो उसने सोचा िक उसका था। यिद कटोरे म� 16 िमठाई बच जाती ह�, तो शु�आत म� कटोरे म� िकतनी िमठाई थी?
Options :
1.  27
2.  36
3.  48
4.  54
  
Question Number : 69 Question Id : 25498919880 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Four words have been given, out of which three are alike in some manner, while the fourth one is different. Choose out the odd one.
Options :
1.  Seal
2.  Scorpion
3.  Fish
4.  Lion



  
Question Number : 69 Question Id : 25498919880 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
नीचे िवक�ो ंम� चार श� िदए गए ह� िजनम� से तीन िकसी �कार से एक जैसे ह�, जबिक एक इनसे िभ� है। उस िभ� श� की पहचान कर�।
Options :
1.  सील
2.  िब�ू
3.  मछली
4.  िसंह
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Question Number : 70 Question Id : 2549895242 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
In which of the following years was General Agreement on Tariffs and Trade (GATT) absorbed into the World Trade Organisation (WTO)?
Options :



1.  1991
2.  1995
3.  2000
4.  2005
  
Question Number : 70 Question Id : 2549895242 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
िन�िल�खत म� से कौन-से वष� म� शु� और �ापार पर सामा� समझौता (GATT) को िव� �ापार संगठन (WTO) म� शािमल िकया गया था?
Options :
1.  1991
2.  1995
3.  2000
4.  2005
  
Question Number : 71 Question Id : 2549895513 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Significance of mitosis cell division is:
Options :
1.  increasing cellular mass.
2.  swift division.
3.  to occur in every tissue of body.
4.  to produce cell genetically similar to parent cell.
  
Question Number : 71 Question Id : 2549895513 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
माइटोिसस कोिशका िवभाजन का �ा मह� है?
Options :
1.  कोिशका ��मान म� वृ�� करना।



2.  िवभाजन ती�ता से होता है।
3.  शरीर के ��ेक ऊतक म� उ�� होने के िलए।
4.  आनुवंिशक �प से जनक कोिशका के समान कोिशका का िनमा�ण करने के िलए।
  
Question Number : 72 Question Id : 2549899644 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Who wrote a book describing the theory of economic drain of India during British rule?
Options :
1.  Lala Lajpat Rai
2.  Mahatma Gandhi
3.  Jawahar Lal Nehru
4.  Dadabhai Naoroji
  
Question Number : 72 Question Id : 2549899644 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
ि�िटश शासन के दौरान भारत की आिथ�क िनकासी के िस�ांत का वण�न करने वाली िकताब िकसने िलखी थी?
Options :
1.  लाला लाजपत राय
2.  महा�ा गांधी
3.  जवाहर लाल नेह�
4.  दादाभाई नौरोजी
  
Question Number : 73 Question Id : 2549899805 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Who wrote the book ‘Life Divine’?
Options :
1.  Mulk Raj Anand
2.  Abul Kalam Azad



3.  Aurobindo Ghosh
4.  Jawahar Lal Nehru
  
Question Number : 73 Question Id : 2549899805 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
'लाइफ िडवाइन' पु�क िकसने िलखी थी?
Options :
1.  मु� राज आनंद
2.  अबुल कलाम आज़ाद
3.  अरिबंदो घोष
4.  जवाहर लाल नेह�
  
Question Number : 74 Question Id : 2549899810 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
To which part of India did the poet Iqbal, who wrote ‘Sare Jahan Se Achchha Hindustan Hamara’, belong?
Options :
1.  Delhi
2.  Uttar Pradesh
3.  Punjab
4.  Hyderabad
  
Question Number : 74 Question Id : 2549899810 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
किव इकबाल िजसने 'सारे जहां से अ�ा िहंदो�ां हमारा' िलखा था, वह भारत के िकस भाग से संबंिधत थे?
Options :
1.  िद�ी
2.  उ�र �देश
3.  पंजाब



4.  हैदराबाद
  
Question Number : 75 Question Id : 25498912825 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
The first Indian doubles who won a Bronze medal at the World Badminton Championship 2011 at London consisted of:
Options :
1.  Jwala Gutta and Ashwini Ponnappa
2.  Saina Nehwal and Jwala Gutta
3.  Saina Nehwal and Ashwini Ponnappa
4.  Jwala Gutta and Harpreet Jadeja
  
Question Number : 75 Question Id : 25498912825 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
लंदन म� आयोिजत िव� बैडिमंटन चै��यनिशप 2011 म� पहली बार कां� पदक जीतने वाली पहली भारतीय युगल टीम म� कौन शािमल थे?
Options :
1.  �ाला गु�ा और अि�नी पोन�ा
2.  सायना नेहवाल और �ाला गु�ा
3.  साइना नेहवाल और अि�नी पोन�ा
4.  �ाला गु�ा और हर�ीत जडेजा
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Question Number : 76 Question Id : 25498940809 Question Type : TYPING TEST Display Question Number : Yes Calculator : None
Summer camps are supervised camps conducted to entertain as well as equip students with various life skills such as teamwork,
socializing, decision making, independent and responsible living and more. It aids the overall development of a child and children have
fun during this process as they get to explore new arenas.
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Question Number : 77 Question Id : 25498937894 Question Type : TYPING TEST Display Question Number : Yes Calculator : None



Climate change includes both global warming and the resulting large scale shifts in weather patterns. There have been previous periods
of climatic change but since the mid twentieth century humans have had an unprecedented impact on Earth climate system and caused
change on a global scale. The largest driver of warming is the emission of gases that create a greenhouse effect of which more than ninety
percentage are carbon dioxide and methane. Fossil fuel burning for energy consumption is the main source of these emissions with
additional contributions from agricultural deforestation and manufacturing. The human cause of climate change is not disputed by any
scientific body of national or international standing. Temperature rise is accelerating. It is tempered by climate feedbacks such as loss of
sunlight reflecting snow or ice cover and increased water vapours. Changes in land and ocean carbon sinks are also a climate feedback.
Temperature rise on land is about twice the global average increase leading to desert expansion and more common heat waves plus
wildfires. Temperature rise is also amplified in the Arctic where it has contributed to melting permafrost glacial retreat and sea ice loss.
Warmer temperatures are increasing rates of evaporation causing more intense storms and weather extremes. Impacts on ecosystems
include the relocation or extinction of many species as their environment changes most immediately in coral reefs mountains and the
Arctic. Climate change threatens people with various problems such as food insecurity or water scarcity and flooding along with
infectious diseases and extreme heat waves. These human impacts have led the World Health Organization to call climate change the
greatest threat to global health in the twenty first century. Even if efforts to minimise future warming are successful some effects will
continue for centuries including rising sea levels and ocean temperatures. The Intergovernmental Panel on Climate Change has issued a
series of reports that project significant increases in these impacts as warming continues at a rapid rate. Further additional warming also
increases the risk of triggering critical thresholds called tipping points. Responding to these impacts involves both mitigation and
adaptation. Mitigation or limiting climate change consists of reducing greenhouse gas emissions and removing them from the
atmosphere. Methods to achieve this include the development and deployment of low carbon energy sources such as wind and solar
energy and a phase out of coal enhanced energy. Forest preservation is another important aspect of mitigation. Adaptation consists of
adjusting to actual or expected climate such as through improved coastline protection and better disaster management along with
assisted colonisation and the development of more resistant crops. Adaptation alone cannot avert the risk of severe widespread and
irreversible impacts. The environmental effects of climate change are broad and far reaching. Changes may occur gradually or rapidly.
Evidence for these effects comes from studying climate change in the past and from modern observation. Since the droughts and heat
waves have appeared simultaneously with increasing frequency. Extremely wet or dry events within the monsoon period have increased
in India and East Asia. The rainfall rate and intensity of hurricanes and typhoons is likely increasing. Frequency of tropical cyclones has
not increased as a result of climate change. Global sea level is rising as a consequence of glacial melt and melt of the ice sheets in
Greenland and Antarctica.
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Question Number : 78 Question Id : 25498944359 Question Type : TYPING TEST Display Question Number : Yes Calculator : None
एक बार की बात है, अकबर और बीरबल िशकार पर जा रहे थे। अभी कुछ समय की उ�� एक िहरण िदखा। ज�बाजी म� तीर िनकालते �ए अकबर
अपने हाथ पर घाव लगा बैठा। अब हालात कुछ ऐसे थे की अकबर ब�त दद� म� था और गु�े म� भी।
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काम न करने का तथा िकसी �वसाय म� अिभ�िच न होने का कारण यह है िक एकसी ��थित म� रहते �ए मनु� को उकताहट पैदा होती है। यह
�ाभािवक भी है। मनोरंजन की आव�कता सभी को होती है। स�महा�ा भी �कृित दश�न और तीथ� या�ा आिद के �प म� मनोरंजन �ा� िकया
करते ह�। यह उकताहट यिद स�ाली न जाय तो िकसी �सन के �प म� ही फूटती है। �सन की शु�आत खाली समय म� कुसंगित के कारण ही होती
है। आजकल इस �कार के साधनो ंकी िकसी �कार की कमी नही ंहै। िन��ाह और मानिसक थकावट दूर करने के िलये िविवध मनोरंजन के साधन
आज ब�त हो गये ह� िक�ु समय के सदुपयोग और जीवन की साथ�कता की �ि� से, इनम� से उपयोगी ब�त कम ही िदखाई देते ह�। अिधकांश तो
धनसा� और मनु� का नैितक पतन करने वाले ही ह�। इसिलए यह भी आव�क हो गया है िक जब कुछ समय �म से उ�� थकावट को दूर करने
के िलए िनकाल� तो यह भलीभांित िवचार कर ल� िक यह जो समय उ� काय� म� लगाने जा रहे ह� उसका आ�िवकास के िलये �ा सदुपयोग हो रहा
है। मनोरंजन केवल �सु� वासना की पूित� के िलये न हो वरन उसम� भी आ�क�ाण की भावना बनी रहे तो उस समय का उपयोग साथ�क माना जा
सकता है। फुरसत और खाली समय का उपयोग अ�ेबुरे िकसी भी काम म� हो सकता है। नवीन�ान, कला, लेखन, से नई सूझ जागृत होती है। इससे
अपना व समाज दोनो ंका क�ाण होता है। स�म� म� लगाये �ए समय से मनु� का जीवन सुखी, समु�त तथा उदा� बनता है। जापान की उ�ित का
�मुख कारण फुरसत के समय का सदुपयोग ही है। वहां सरकारी काम के घ�ो ंके बाद का समय लोग, छोटे छोटे �खलौने, इले�� ािनक सामान आिद
बनाने म� लगाते ह�, खाली समय का उपयोग िजस �कार के कामो म� कर� गे वैसी ही उ�ित अव� होगी। आलस म� समय गंवाने वाले कुसंग से उ�े
रा�े तैयार करते ह�। कहते ह� खाली िदमाग शैतान का घर। जब कुछ काम नही ंहोता तो खुराफात ही सूझती है। िज�� िकसी स�ाय� या �ा�ाय म�
�िच नही ंहोती खाली समय म� कुसंगित, दु��सन, ताशतमाशे और तरहतरह की बुराइयो ंम� ही अपना समय िबताते ह�। समाज म� अ�व�था का
कारण कोई बाहरी श�� नही ंहोती, अिधकांश बुराइयां, कलह और झंझट उ�� करने का �ेय उ�ी ंको है जो �थ� म� समय गंवाते रहते ह�। मनु�
ल�े समय तक िन�योजन खाली बैठा नही ंरह सकता अतएव यिद वह भले काम नही ंकरता तो बुराई करने म� उसे देर न लगेगी। उसे अ�ा या बुरे,
स�ा हो चाहे का�िनक, ��� या अ��� कुछ न कुछ करना ही होगा। इसिलये यिद उसे सही िवषय न िमले तो वह बुराइयां ही �हण करता है
और उ�� ही समाज म� िबखेरता �आ चला जाता है। मनु� के अंतकरण म� ही उसका देव� और असुर� मौजूद है। जब तक हमारा देवता जागृत
रहता है और हम िविभ� क�ाणकारी कामो म� संल� रहते ह� तब तक आ��रक असुरता भी दबी �ई रहती है पर यह �सु� वासनाय� भी अवकाश
के िलये चुपचाप अ�म�न म� जगती रहती ह� समय पाते ही देव� पर �हार कर बैठती ह�।
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